MICROSOFT PROJECT TUTORIAL

INTRODUCTION

Microsoft Project is a Windows-based project management software package. It provides the flexibility to help manage your project, provides assistance in every phase of the project, calculates schedules and other project information. It helps to build the project plan and also helps in tracking it to its completion. Microsoft project supports calendar controls, allocation of resources, production of PERT, GANTT charts, resource charts, calendar charts and dozens of reports. Its easy to navigate & similar to other MS packages. MICROSOFT PROJECT can be of substantial assistance in the management of projects. It does not produce or print a delineated work breakdown structure, although it does generate work breakdown structure numbers. Its primary advantage is its widespread use and the availability of hundreds of add-ins.

Installing MS Project

MS project is located on your source CD-DROM and must be installed before it can be used. When installed, it usually positions itself in the MS office folder.

GETTING STARTED

Click on the START button in the lower-right-hand corner of your windows screen, then click on Programs, then Microsoft Office and finally Microsoft Project.

1. To open a new project file, click on the new button on the tool bar. The project information dialog box opens, as exhibited below:
2. In the **project information** window, enter the project start date; otherwise, by default today’s date is taken. You will notice that in the third text box, you can specify whether you want the project scheduled from the start date or from the completion date. In the former case, tasks begin as soon as possible. In the latter case tasks begin as late as possible. Click on the drop-down arrow associated with the third text box and select the second of the two alternatives and then select the first again. Note how the comment underneath changes. Now, click **OK**.

You are placed in the Gantt view of the project. This is really a combination of two views in one. On the left, you have a table that you can change. On the right you have the typical Gantt chart. You can move the partition between two simply by attaching the cursor to the partition edge and dragging it to the left or to the right. Dragging it to the right reveals more of the table, but lessens the amount of the Gantt chart that is in view. Dragging it to the left does just the opposite.

3. Click on **save** & give the project a name.

![Fig1: The Gantt view within MS Project](image-url)
ENTERING TASKS

1. Click View on the menu bar at the top of the display. With the View menu pulled down, click Gantt Chart. In most cases this was the view you were placed in to begin with so nothing changes.
2. In the Task name field, type in several task names, one to a line.
3. Use the down arrow to move to the line below after typing a task name.
4. In order to insert a task, between two tasks, position the cursor on the task above the point in which the insertion is to be made. Click on insert on the menu bar and then enter the task name.

Once you’ve entered a task name, simply hit the down arrow, to enter the next name on the line below. If you should skip a task, its easy to go back and insert the task in the list. Position the cursor on the cell of the task that is to have a task inserted before it. Click on Insert on the menu bar and then Insert Task. MICROSOFT PROJECT will insert a task row.

SPECIFY SUBORDINATION.

This is basically a grouping tasks into phases, which makes it easier to track a project and also makes it easier to read the task list. Grouping is done by indenting tasks. A task can also be removed from a group and that is called out-denting. Tasks that are subordinate to a higher level task on the work break down structure are so indicated by subordination.

INDENTING & OUT-DENTING TASKS

1. In the Task name field, select the task you want to indent or out-dent by “boxing” it as you would in any spreadsheet. Boxing is done by simply clicking on the cell in which the task resides.
2. Click on the indent ( → ) button to indent the task or out-dent ( ← ) button to outdent the task. These buttons are found on the second row of tools below the menu bar in the upper-left-hand corner.

You can also highlight a number of tasks and then click on the indent button to indent the entire collection of tasks at once.

NOTE: MS Project assigns numbers to the task to indicate the level of the task. These are called outline numbers. If we indent 3 tasks under a particular task say task no.1 then the 3 tasks are numbered as 1.1,1.2,1.3.

To display the outline no.s in the task name field, click on the Tools menu item on the menu bar. From the drop-down menu, click options... and then click the view tab. To show outline no.s, under outline option, click the Show outline numbers check box.
Note that MS Project sets a default duration of one day for each task that you entered or inserted above. You will obviously have to change many of these. Doing so requires the following.

1. In the **Duration field** enter the duration.
2. After entering the duration, you may press the **down arrow** or hit <Enter>.

   Note: A **milestone** is a task whose duration is zero days. Any task can be changed to a milestone by changing duration to zero.

You will not need to enter the durations of tasks which have subtasks subordinated below them. These tasks have their durations calculated as the sum of all the demoted task durations. THINK OF TASKS THAT HAVE SUBTASKS AS A SUMMARY OF ALL THE SUBTASK INFORMATION that is subordinate to them. Consider the following list of tasks:

<table>
<thead>
<tr>
<th>NO.</th>
<th>NAME</th>
<th>DURATION</th>
<th>PRED.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>Analysis</td>
<td>17</td>
<td>1</td>
</tr>
<tr>
<td>2.1</td>
<td>Interviews</td>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Management</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Supervisor</td>
<td>2</td>
<td>2.1.1</td>
</tr>
<tr>
<td>2.1.3</td>
<td>Technical</td>
<td>2</td>
<td>2.1.2</td>
</tr>
<tr>
<td>2.1.4</td>
<td>Clerical</td>
<td>2</td>
<td>2.1.3</td>
</tr>
<tr>
<td>2.2</td>
<td>Anal Existing Doc</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>2.3</td>
<td>Synthesis</td>
<td>3</td>
<td>2.2</td>
</tr>
<tr>
<td>2.4</td>
<td>Functional Spec</td>
<td>5</td>
<td>2.3,2.1.4</td>
</tr>
<tr>
<td>2.5</td>
<td>Re-estimate</td>
<td>1</td>
<td>2.4</td>
</tr>
<tr>
<td>2.6</td>
<td>Development Prop</td>
<td>4</td>
<td>2.5</td>
</tr>
<tr>
<td>2.7</td>
<td>Presentation</td>
<td>4</td>
<td>2.5</td>
</tr>
</tbody>
</table>

Note that, in the list above, Analysis duration is exactly as long as necessary to accommodate all of its subtasks and sub-subtasks. MICROSOFT PROJECT will figure this out automatically. Thus once all the subtask and sub-subtask durations are entered, MICROSOFT PROJECT will compute the duration automatically of the associated task. It is not possible for the user to change this. The same can be said for subtasks when they have sub-subtasks. Again, MICROSOFT PROJECT will not allow you to change the duration of a task that has subtasks.

MS Project 2000 accepts durations in minutes, hours, days or weeks. When entering data into the duration field, use the following designations for minutes (m), hours (h), days (d), or weeks (w). The default is days (d) and therefore, the "d" is optional and need not be entered when the intent is to enter durations in days. Thus, if the scheduled duration of a task is 6 days, simply press 6 and then hit <Enter>.

MS Project 2000 has its own built-in understanding of time and it is making a lot of assumptions about the way in which you work. For example, it is assuming 8-hour work days, five-day work weeks and that you do not work on Sat. or Sun. To see this, view the
project in the Calendar view; notice the duration of the tasks and how they fall across weekends as necessary to fill up the required number of weekdays.

**Automated Features of MS Project**

MICROSOFT PROJECT creates automatically assigned Task ID numbers. You can change these, but you cannot assign a task ID number that has already been assigned. Note also that MICROSOFT PROJECT has its own built-in understanding of time and it is making a lot of assumptions about the way in which you work. For example, it is assuming 8-hour work-days, five-day work weeks and that you do not work on Sat. or Sun. To see this view the project in the Calendar view; notice the duration of the tasks and how they fall across weekends as necessary to fill up the required number of weekdays.

**Inserting Columns**

You can insert columns within any table in the Gantt view. Make certain that your first task is a summary task under which all other tasks are subordinated. Include a cost column in the entry table next to the duration column. You can also include “major function,” “output,” and “input” columns within the entry table simply by clicking on Insert and then Column and typing in the name of the column, followed by clicking on OK.

**SHOWING TASK PRECEDENCE**

This is done to show the time-sequential relationship between two tasks. To show that a particular task can begin only when the predecessor task has completed, the two tasks must be linked. After you decide the task sequence, you can link the tasks, as follows.

**LINKING TASKS**

1. In the task name field, select two or more tasks that you want to link. To select more than one task, use the <Ctrl> button in conjunction with the left-click button on the mouse for every task selected after the first. To avoid confusion, it is best to select only a pair of tasks at a time. The first task you click on will be assumed to be the precedent task and the second task that you click on will be assumed to be the subsequent task.
2. Click the Link task button on the tool bar. It is the button with the solid chain link icon.

MS Project generally links tasks as Finish-to-Start tasks, i.e. the second task begins only when the preceding task has completed. Several precedent tasks can be linked into a single subsequent task, but this has to be done in pairs in which each precedent task is clicked on first, followed by a click on the subsequent task.
To Link the task in start to start/ finish to finish/start to finish dependency, the following steps should be followed.

1. In the task name field, double click the task you want to link. The task information dialog box appears.
2. Click the predecessor tab.
3. In the ID field, type the ID number of the predecessor task (this is the number in the column to the left of task name field). The type box should show the default finish/start relationship.
4. Click in the Type box and then click the drop down arrow to see the four types of dependency relationships that can be established.

You can also select link under the Edit menu item on the menu bar after selecting the pair of tasks to be linked. Alternatively, you can use the shortcut key <Ctrl><F2>. To unlink tasks use Edit/unlink or use <Shift><Ctrl><F2> after highlighting the associated task names. As indicated, the default link type is a FINISH/START link, that is, a link in which the succeeding task is not allowed to start until the preceding task is complete. However, START/START links and FINISH/FINISH links are also possible. In these latter cases, the analyst wants tasks to start together or finish together. To change the link type, identify the starting task by clicking on it. Then press <Shift><F2> to display the Task Information dialog box. Select the predecessors tab and click on the link type field. To specify Start/Start links type SS. To specify a Finish/Finish relationship, type FF. The default link type is FS, but this can be changed in the dialog box to SS or FF.

**SETTING HARD START DATES, STOP DATES**

It is possible to set hard start dates, stop dates for tasks in MS Project. To do so, begin in the Gantt View with the Entry table visible. Slide the partition to the right to expose as much of the entry table as possible. You should see two side-by-side columns—the start column and the finish column. By changing any of the dates in these columns, you are setting a hard date constraint. If you do so, a flag will appear in the very first column of the entry table, the column labeled I for information. If you rest the cursor on that flag, a message appears that informs you of the hard date constraint that has been applied to the task. Only one hard date constraint can be set per task—at the start date or at the stop date, but not both.

**ASSIGNING RESOURCES**

An assignment is the pairing of a resource to a task. A RESOURCE is a person and/or equipment item needed to accomplish the task. Resources can be places, departments, businesses, people, equipment--anything required to complete an activity. When you create an assignment, you assign a resource to a task. The resource issue makes the project
management picture far more robust. MICROSOFT PROJECT can accommodate situations where the assigned resource is not available at the time the task is to start, or is available for a few hours each day. MICROSOFT PROJECT assigns costs to tasks on the basis of the resource hours consumed by those tasks.

You can assign:
- Individual resources
- Assign resources part time
- Several resources
- Remove resources from a task
- Replace one resource with another.

ASSIGNING RESOURCES TO TASKS

1. In the Task name field, select the task to which you have to assign a resource.
2. Click on the assign resource button on the tool bar (button with 2 faces on it).
3. In the Name field, type in the name of the resource.
4. Click assign.

Note: By default MS Project assigns 100% of the resource to the task. To change this & assign it say part time, type a percentage less than 100 in the Units field.

ASSIGNING SEVERAL RESOURCES

Several resources can be assigned to a single task. When such is done, MS Project will cut the duration of the task in half, assuming that each resource is working 100% on the task and that the two together are twice as fast as either would be alone. This is a bad assumption in the software business because as Brooks [1] pointed out, men and months are not interchangeable unless there is no interaction between them. If you decide to split your job with another person, you will have to spend some time training the other person to do your part of the job. Then you will have to interact with the other person as the two of you together build the interfaces that are necessary between each person’s module(s). Clearly, the time is not split in half.

REMOVING RESOURCES FROM A TASK

1. In the Task name field, select the task to which you have to remove a resource.
2. Click on the assign resource button (button with 2 faces on it).
3. Select the resource you want to remove.
4. Click Remove.

PRINTING THE REQUIRED VIEW

MS Project provides many views of the project that can be printed out. As a minimum, they are the Gantt view, the PERT chart view, the Task Usage view, the Tracking Gantt View and the Calendar view. To print the required view,
1. select the view from the left hand side tool bar or from use of the VIEW item on the menu bar;
2. click on file item on the menu bar, and select print.

AN EXERCISE

In this exercise you are going to enter the following tasks along with each task’s duration (in days) and the predecessor tasks into Microsoft Project.

<table>
<thead>
<tr>
<th>NO.</th>
<th>WBS</th>
<th>NAME</th>
<th>DURATION</th>
<th>PREDECESSOR TASK</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>IT PROJECT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1.1</td>
<td>Definition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1.1.1</td>
<td>Interviews</td>
<td>2d</td>
<td>1.1.1</td>
</tr>
<tr>
<td>4</td>
<td>1.1.2</td>
<td>Prep Req. Doc.</td>
<td>2d</td>
<td>3</td>
</tr>
<tr>
<td>5</td>
<td>1.1.3</td>
<td>Prep Proj Plan</td>
<td>2d</td>
<td>4</td>
</tr>
<tr>
<td>6</td>
<td>1.1.4</td>
<td>Prep Proposal</td>
<td>2d</td>
<td>5</td>
</tr>
<tr>
<td>7</td>
<td>1.2</td>
<td>Analysis</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>1.2.1</td>
<td>Interviews</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1.2.1.1</td>
<td>Management</td>
<td>1d</td>
<td>1.2.1.1</td>
</tr>
<tr>
<td>10</td>
<td>1.2.1.2</td>
<td>Supervisor</td>
<td>2d</td>
<td>1.2.1.2</td>
</tr>
<tr>
<td>11</td>
<td>1.2.1.3</td>
<td>Technical</td>
<td>2d</td>
<td>1.2.1.3</td>
</tr>
<tr>
<td>12</td>
<td>1.2.1.4</td>
<td>Clerical</td>
<td>2d</td>
<td>1.2.1.4</td>
</tr>
<tr>
<td>13</td>
<td>1.2.2</td>
<td>Anal Existing Doc</td>
<td>3d</td>
<td>1.2.2</td>
</tr>
<tr>
<td>14</td>
<td>1.2.3</td>
<td>Synthesis</td>
<td>3d</td>
<td>1.2.3</td>
</tr>
<tr>
<td>15</td>
<td>1.2.4</td>
<td>Functional Spec</td>
<td>5d</td>
<td>1.2.4</td>
</tr>
<tr>
<td>16</td>
<td>1.2.5</td>
<td>Re-estimate Plan</td>
<td>1d</td>
<td>1.2.5</td>
</tr>
<tr>
<td>17</td>
<td>1.2.6</td>
<td>Development Prop</td>
<td>4d</td>
<td>1.2.6</td>
</tr>
<tr>
<td>18</td>
<td>1.2.7</td>
<td>Presentation</td>
<td>1d</td>
<td>1.2.7</td>
</tr>
<tr>
<td>19</td>
<td>1.3</td>
<td>Design</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>1.3.1</td>
<td>System Design</td>
<td>5d</td>
<td>1.3.1</td>
</tr>
<tr>
<td>21</td>
<td>1.3.2</td>
<td>Walk-through</td>
<td>1d</td>
<td>1.3.2</td>
</tr>
<tr>
<td>22</td>
<td>1.3.3</td>
<td>File Design</td>
<td>2d</td>
<td>1.3.3</td>
</tr>
<tr>
<td>23</td>
<td>1.3.4</td>
<td>Walk-through</td>
<td>1d</td>
<td>1.3.4</td>
</tr>
<tr>
<td>24</td>
<td>1.3.5</td>
<td>Acc. Test Plan</td>
<td>4d</td>
<td>1.3.5</td>
</tr>
<tr>
<td>25</td>
<td>1.3.6</td>
<td>Design Spec</td>
<td>5d</td>
<td>1.3.6</td>
</tr>
<tr>
<td>26</td>
<td>1.4</td>
<td>Construction</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>1.4.1</td>
<td>Plan the integration</td>
<td>4d</td>
<td>1.4.1</td>
</tr>
<tr>
<td>28</td>
<td>1.4.2</td>
<td>Module Design</td>
<td>5d</td>
<td>1.4.2</td>
</tr>
<tr>
<td>29</td>
<td>1.4.3</td>
<td>Walk-through</td>
<td>1d</td>
<td>1.4.3</td>
</tr>
<tr>
<td>30</td>
<td>1.4.4</td>
<td>Plan module testing</td>
<td>2d</td>
<td>1.4.4</td>
</tr>
<tr>
<td>31</td>
<td>1.4.5</td>
<td>Coding</td>
<td>5d</td>
<td>1.4.5</td>
</tr>
<tr>
<td>32</td>
<td>1.4.6</td>
<td>Module Test</td>
<td>5d</td>
<td>1.4.6</td>
</tr>
<tr>
<td>33</td>
<td>1.4.7</td>
<td>User documentation</td>
<td>5d</td>
<td>1.4.7</td>
</tr>
<tr>
<td>34</td>
<td>1.5</td>
<td>System Test</td>
<td>5d</td>
<td>1.5</td>
</tr>
</tbody>
</table>

You will only be entering the data in the NAME, DURATION and PREDECESSOR TASK fields. The numbers to the left will appear automatically if you add the WBS column as demonstrated in class. Be sure to add the WBS and COST fields to the entry table that is shown in the Gantt chart view. The numbers shown in the WBS column above are there to indicate subordination. However, MICROSOFT PROJECT will do the work breakdown structure numbers you see above if you do the subordination (indentation) correctly. Interviews, Anal Existing Doc, Synthesis, Functional Spec, Re-estimate, Development Prop and Presentation are all subtasks within Analysis. This is precisely what the 1.2.x is intended to designate. Likewise, 1.2.1.1 Management
1.2.1.2 Supervisor
1.2.1.3 Technical
1.2.1.4 Clerical
are all subsubtasks of subtask 1.2.1 Interviews. It will be necessary for you to DEMOTE these subtasks and sub-subtasks appropriately in MICROSOFT PROJECT by use of the demotion (INDENT) arrow in the Gantt Chart view.

Assign the following resources to the tasks:

<table>
<thead>
<tr>
<th>RESOURCE</th>
<th>TASK</th>
<th>HOURLY RATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kirk Kennedy</td>
<td>3, 4, 9, 13, 21, 23, 29</td>
<td>$50</td>
</tr>
<tr>
<td>Norbert Norris</td>
<td>5, 6, 10, 13, 14, 16, 21, 23, 29</td>
<td>$60</td>
</tr>
<tr>
<td>Floyd Ford</td>
<td>11, 17, 18, 21, 23, 29</td>
<td>$70</td>
</tr>
<tr>
<td>Frida Fisher</td>
<td>20, 21, 22, 23, 24, 25, 29</td>
<td>$80</td>
</tr>
<tr>
<td>Judy Johnson</td>
<td>21, 23, 27, 28, 29, 30, 31</td>
<td>$40</td>
</tr>
<tr>
<td>Ben Brown</td>
<td>21, 23, 29, 32, 33, 34</td>
<td>$50</td>
</tr>
</tbody>
</table>

Determine the total time and total budget required to complete this project. Notice that, for the walk-throughs, all resources get assigned. MS Project will try to cut the duration to something less than one day. You must re-set the duration to one day for the walk-throughs once all resources have been assigned. Printout the Entry Table with the WBS and COST fields added and its associated Gantt chart—turn in with your homework. Explain why (in writing) it makes sense to include a PROJECT task at the very beginning of your list of tasks. Explain why summary tasks have no stated duration in the table above. Explain why the first subordinate task immediately below a summary task has no predecessor.

The end result of all of these tasks and assignment entries is the following:
Fig7a.2. Gantt view of MS Project
The Network or PERT Chart View
ESTIMATING & MANAGING COSTS

Estimating costs and assigning them to tasks & resources, helps you to develop a project budget. It also helps you to determine how closely the final project cost matches its estimated cost and also helps in planning for the future.

ASSIGNING A RATE TO A RESOURCE

MS Project helps us to assign hourly or fixed rates to resources. For hourly rates, you can assign a standard rate, which is the rate you pay a resource during normal working hours. Ovt. Rate is the amount you will pay the resource for any overtime that it does. To resources that charge a flat amount to do a job, you can assign a fixed cost per use.

1. On the View bar on the left, click Resource sheet
2. In the Std. Rate, Ovt. Rate and Cost/Use field for the resource, type the rates that apply, and then press ENTER.

ASSIGNING A FIXED COST TO A TASK

1. On the View Bar, click Gantt Chart.
2. On the View menu, click on Table, select Cost from the list and then click on Cost.
3. In the Fixed Cost field for the task, type-in the cost
4. Press ENTER.

ASSIGNING A FIXED RESOURCE COST TO A TASK

A resources cost can be fixed for a task, e.g., a contractor charging a flat rate to do a job. A fixed resource cost is added to other resource costs when MS Project calculates the total cost of a task, but doesn’t depend on the time a resource spends working on the task.

1. On the View Bar, click Gantt Chart.
2. In the Task Name field, select a task.
3. On the Window menu, click Split.
4. In the Resource Name field, select the resource name. If a new, undefined resource is to be assigned, it must be added to the list, so do so.
5. On the format menu, point to details and then click Resource Cost.
6. In the Task type box, click Fixed Duration.
7. In the units field for the resource, type 0 and then click OK
8. In the Cost field, type the fixed resource cost.
9. On the Window menu, click Remove Split. Notice how this task is displayed on the Gantt Chart.

VIEWING COSTS

MS Project provides numerous ways to examine costs associated with a project. You can:
✓ View the cost per task.
✓ View cost per resource.
✓ View the total project cost.

**View cost per task**
The sum of individual task costs make up most if not all of the total project cost. To view the total cost of each task
1. On the vertical View Bar on the left, click Gantt Chart.
2. Select View on the menu bar, click Table, and then choose Cost.
3. Scroll the table on the left to view the Total Cost field. Alternatively, pull the partition back to the right to view more of the table and less of the Gantt Chart.

**View the cost per Resource**
This helps you to know the total cost of that resource for all the tasks the resource is assigned to.
1. On the vertical View Bar on the left, click Resource Sheet.
2. Select View on the menu bar, point to the table, and then click Cost

**View Total Project costs**
1. On the Project menu, click Project Information.
2. Click Statistics.

Perhaps you would like to view project costs on the Entry table which is the default table that loads up with MS Project 2000 when it is booted. You would like an additional column to appear right after the name field and right before the duration field. You can get MS Project to insert such a column into your Entry Table. First position the highlight anywhere in the duration column. The click on the insert item on the menu bar. Then, click on Column… 
In the Column Definition dialog box that appears, click on the drop down arrow associated with the Field Name field, the first field in the box. The list of columns that you can insert appear alphabetized by name. Scroll to cost and click on it. Now, click on the OK button in the upper right corner of the box. The column now appears in your table exactly where you want it. And, now you can see all of your costs.

---

**ANALYZING A PROJECT.**

The main goals of analyzing your project plan are to:
- Shorten the schedule, to meet project deadline.
- Distribute the work load evenly, by resolving resource over allocations, so that no resources are overworked.
- Reduce costs to a minimum, to save money and complete the project within your budget.

*THE MOST IMPORTANT PART OF THE PLAN IS THE SCHEDULE.* By adjusting the schedule, you can schedule a task to start and finish sooner, bring in the project finish date, shrink task duration’s and distribute the workload more evenly.*
Before you analyze and adjust a task’s schedule, you need to know what factors affect its schedule. The main factors that affect how MS Project determines a task’s start and finish dates are:

- **Placement.** In a logically ordered set of tasks, the tasks are usually performed in the order in which they appear in the task list. Eg. a task near the top of the list occurs at the beginning of the project, a task in the middle of the list occurs in the middle of the project.

- **Duration.** Several factors affect duration, but, in general, the longer the duration you enter, the later a task finishes. Changing the duration may change the task finish date.

- **Task dependencies.** The type of link you establish between two tasks determines whether the successor task starts after the predecessor task is complete. By replacing one type of link with another, you can change the task’s start and finish dates and, perhaps, the project end date.

- **Overlap and delay.** The overlap or lead-time you add between two tasks causes the successor task to begin earlier. The delay or lag time between two tasks causes the successor task to begin later.

- **Constraints.** You can force a task to start or finish on or near a date you specify by entering a start or finish date yourself or you can change the default constraint, as soon as possible to an inflexible constraint such as Must start on or Finish no later than. Its however better to let MS Project calculate and, if the schedule changes, recalculate.

- **Assigned resources.** When you assign resources to a task, the task duration can change. Generally, more the resources you assign to a task; shorter its duration becomes.

- **Work.** If you assign resources to a task, then by default, MS Project calculates a task duration based on the amount of work required to complete the task, the number of resources allotted, the working times and work assigned to the resources. By changing the amount of work required to accomplish a task, you can change the task duration and thus the final date.

- **Task type.** By default each task is a fixed units task. You can change the task type to fixed duration or fixed work.

Other factors that affect how a task is scheduled are the project start date, the day of the week on which it starts, & whether you split a task into portions, with an interruption between each portion.

### Determining Critical Tasks

In every project there are tasks that can delay a project if they are not completed on time and tasks that can be completed after their original finish time without affecting the project finish date. Tasks that can delay a project are called critical tasks and the ones that do not delay are called non-critical tasks.

Critical tasks make up a special path known as the critical path. The critical path is the sequence of tasks that ends on the latest finish date, i.e., the finish date of the last task in the critical path is the project finish date. As previously mentioned in the main body of this chapter, the critical path is the longest path through the network and the path that determines the duration of the total project. When you want to shorten the schedule, the critical path has to be shortened.

### Identifying the Critical Path

There are several ways to get MS Project to exhibit the critical path in red. For one you can right click anywhere in the Gantt Chart, select Gantt Chart Wizard and select Critical Path off the list of options that it gives you. Another way is to change the view as follows:

1. On the **View bar**, click **More views**.
2. On the **View lists**, select **Detail Gantt** or **Tracking Gantt** and then click **Apply**

### Finding Slack in the Schedule

Free slack is the amount of time a task can be delayed without delaying the finish date of another task.

1. On the **View Bar**, click **more Views**
2. In the **Views list**, click **Detail Gantt**, and then click **Apply**. Slack on a task appears graphically as thin slack bars adjoining the regular Gantt bars.
3. Drag the divider bar to the right to view the free slack and total slack fields. To change the default slack time for critical tasks:
   1. On the tools menu click Options, and then click the Calculation tab.
   2. In the Tasks are critical if slack is less than or equal to box, enter the amount of slack time.

SHORTENING YOUR SCHEDULE
The most effective way to shorten your schedule is to adjust tasks that lie on the critical path. Adjusting non-critical tasks will not shorten the schedule. The actions you can take to shorten your schedule fall into two categories.

- **Shorten task duration**: This can be done by decreasing the duration directly, by decreasing total work, assigning more resources to a task, by assigning overtime work and by increasing a resource’s work schedule.
- **“Compress the schedule by making the tasks start sooner**: This can be done by combining or deleting tasks, breaking down a task into non-critical subtasks, by adding lead time to a task, changing the task dependency, type of task etc.

*Breaking down a critical task into non critical subtasks*
1. On the view bar click more views.
2. On the views list, select Detail Gantt or Tracking Gantt & click Apply.
3. In the Task Name field, select a single task on the critical path that could be completed in several steps.
4. Click Unlink Tasks.
5. Remove the resources assigned to the task.
6. Select the task beneath the task you want to change, and then click new task on the insert menu.
7. Repeat step 6 for each subtask you want to add.
8. For each new task, type a name in the Task name field and a duration in the Duration field.
9. In the task Name field, select all the new tasks, and then click Indent to make them subtasks of the original task. (the original task becomes the summary task, the subtasks will be on the critical path.).
10. Click Link task.

**Exercises**

1. The Irving Companies are a small conglomerate specializing in health-related businesses, from wholesale planning to in-home health care and medical supplies. The company wants to replace its old legacy systems with an ERP system. The tasks required to do this are the following:

```plaintext
<table>
<thead>
<tr>
<th>TASK</th>
<th>DURATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the business case</td>
<td>60 days</td>
</tr>
<tr>
<td>Specify requirements</td>
<td>10 days</td>
</tr>
<tr>
<td>Select an installer/system integrator</td>
<td>10 days</td>
</tr>
<tr>
<td>Select an ERP vendor</td>
<td>10 days</td>
</tr>
<tr>
<td>Install the system</td>
<td></td>
</tr>
<tr>
<td>Install phase 1</td>
<td>10 days</td>
</tr>
</tbody>
</table>
7. Install phase 2 10 days
8. Install phase 3 12 days
9. Perform parameterization
   10. Parameterize phase 1 22 days
   11. Parameterize phase 2 15 days
   12. Parameterize phase 3 14 days
13. Perform Testing
   14. Test phase 1 of the system 20 days
   15. Test phase 2 of the system 20 days
   16. Test phase 3 of the system 30 days
   17. Conduct Overall testing 5 days
   18. Conduct acceptance test 2 days
19. Perform Training
   20. Train for phase 1 cut-over 10 days
   21. Train for phase 2 cut-over 10 days
   22. Train for phase 3 cut-over 12 days
23. Perform Cut-over
   24. Perform phase 1 cut-over 2 days
   25. Perform phase 2 cut-over 3 days
   26. Perform phase 3 cut-over 4 days
27. Assess performance in relation to specs 2 days
28. Closeout 2 days

Implement within MS Project. Determine project duration. Assume one distinct person is assigned to each of the three phases. The person assigned to phase 1 costs $75/hr, while the person assigned to phase 2 costs $95/hr and phase 3 costs $80/hr. Assume all other work is performed by the project manager at $150/hr. Decide what precedence relationships you will require.

Determine the project overall cost. In the project above, describe some ways to get it completed sooner, without adding resources. Turn in the hardcopy of the Gantt View of your project with the entry table shown and a cost column included in that table.

2. For the sequence of steps in the problem above, determine the critical path.